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1 Introduction
1.1 Preface
The setup program is used for the easy creation of configuration files, and to
configure the instruments from a PC.

Please read these instructions before commissioning the software. Keep the
instructions in a place which is accessible to all users at all times.

Please assist us to improve these instructions, where necessary.

Your comments will be appreciated.

H However, if any difficulties should arise during start-up, please do
not carry out any unauthorized manipulations. You could endanger
your rights under the instrument warranty!

Please contact the nearest subsidiary or the head office in such a
case.

B
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1 Introduction
1.2 Typographical conventions

Warning signs

The signs for Danger and Caution are used in this manual under the following
conditions:

A
Caution

This symbol is used when there may be damage to equipment or data if the
instructions are ignored or not followed correctly!

Note signs

H
Note

This symbol is used when your  special attention is drawn to a remark.

v
Reference

This symbol refers to further information in other manuals, chapters or
sections.

abc1
Footnote

Footnotes are remarks that refer to specific points in the text. Footnotes
consist of two parts:

A marker in the text, and the footnote text.

The markers in the text are arranged as continuous superscript numbers.

h

Action instruction

This symbol indicates that an action to be performed is described.

The individual steps are marked by this asterisk, e.g.

h Press the h key

h Confirm with E
8



1 Introduction
Presentation modes

h + E

Keys

Keys are shown in a box. Both symbols and text are possible. If a key has a
multiple function, then the text shown is the one that corresponds to the
function that is active at the moment.

Edit Î
Device data

Menu items

Menu items in the software which are referred to in this manual are shown in
italics. Menu name, menu item and submenu item are separated from each
other by “Î”.

1.3 Hardware and software requirements
The following hardware and software requirements have to be met for
installing and operating the setup program:

Minimum
configuration

- Intel Pentium1 III or higher,

- Microsoft Windows2 NT4.0 (SP6a), 2000 or XP,

- 128Mbyte main memory,

- CD drive,

- mouse,

- one free serial interface or network connection, or 
CompactFlash memory cards (depending on the type 
of data transmission to the paperless recorder), and

- 120Mbyte available on hard disk.

Recommended
configuration

- Intel Pentium 4

- Windows XP or 2000

- 512Mbyte main memory

- 2Gbyte free space on hard disk for data

1. Intel and Pentium are registered trademarks of Intel Corporation
2. Microsoft and Windows are registered trademarks 

of Microsoft Corporation
9
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2 Installation
2.1 Starting the installation

Running the 
installation
program

h Start Microsoft Windows

h Insert the CD into the drive, then close the drive.

After the CD has been inserted, the installation program will start
automatically. If not, proceed as follows: 

h Start the file “Launch.exe” in the main directory of the CD.

Screen messages from the installation program will now lead you through the
rest of the installation.

License
agreement

h Read and confirm the license agreement. Accepting the agreement is the 
basic precondition to be able to install the software.

H If Microsoft Windows has already been started, all Windows 
programs must be shut down before installing the setup program.
11



2 Installation
Available 
software

h Select the components that need to be installed.

License number h Now enter the required license numbers. 
You can find the numbers on the cover of the CD.  

Program folder h Define the program folder into which the icons for starting the software are 
to be copied. The directory for the program files is defined automatically.

Software that is to be installed must be 
marked by a tick ( ).

H If the “demo version” option has been set during installation, then 
some functions of this software (such as data transmission, saving 
data, printing out) will be disabled.

The software can be licensed at a later stage.
12



2 Installation
Carry out 
installation

h The final action is to click on the  button, to initiate the actual 
installation.

Program start The selected software components will now be installed. When installation has
been completed, start the setup program from the Windows start menu.
13



2 Installation
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3 Log-in and rights
3.1 Log-in to the program
When the software has just been installed for the first time, there will not yet be
a query of the user name and password. In the menu Extras, the query at the
start of the program can be activated by the function Renew log-in / Alter
password.
The activation of the log-in function can be used to distinguish between the
user types “Specialist” and “Maintenance”. These two users have different
access rights with regard to the functions in the setup program.

v Chapter 8.10 “Renew log-in / alter password”

If the query is active, proceed as follows:

h Log in.

H Please note that not all functions are available to all users.

v Chapter 3.2 “Rights with regard to the setup program”
15



3 Log-in and rights
3.2 Rights with regard to the setup program
Depending on the installation and the log-in, individual users will have different
rights within the setup program.

The differences are summarized in the table below:

Right Demo
installation

Maintenance Specialist

Write interface texts - x x

New x x x

Open x x x

Save, Save as, 
Delete - x x

Configure undocumented 
parameters - - x

Export to CF card - x x

Import from CF card - x x

Print - x x

Enable 
program options x - x

Enable extra codes - - x

Edit interface settings - x x

Edit device settings x x x

Delete device - - x

Create new device x - x

x = right is available - = right is not available
16



4 User interface
4.1 Elements of the user interface

Menu bar The individual functions of the setup program can be started by using the
menu bar.

v Chapter 5 “File menu”

Toolbar
(symbol bar)

The toolbar contains selected functions from the menu bar. They can be
started from the left mouse button. If you rest the mouse pointer on one of the
icons (tool tips), you will see the function title after a short while. 

Menu bar

Toolbar

Working area

Connection status Teleservice
17



4 User interface
Shifting the  
toolbar

The position of the toolbar can be changed, if desired. 

h Please move the mouse pointer between two icon groups.

h Press the left mouse button. 

h Keeping the left mouse button pressed, drag the symbol bar to the required 
position.

h Now release the mouse button.

Possible positions are:

- the left or right window border (vertical orientation),

- below the menu bar (horizontal orientation),

- at the bottom edge, above the user details (horizontal orientation) or

- any position (in own window -  horizontal orientation).

Working area Here you are provided with an overview of the current settings of a
configuration file. 

v Chapter 4.2 “Configuration”

Connection 
status

In the “Connection status” line you can check whether a connection to a
device has been established, and which interface data are being used. The
line can be made visible or hidden through Window ➔ Connection status.

Example: No connection

Example: Connection to a device

The line can be moved (like the toolbar). In order for the shift to work, first
position the mouse pointer on the  symbol, then press the left mouse  button.

Teleservice You can use Teleservice to look at the latest data from a paperless recorder.
Teleservice can be made visible or hidden through the function Window ➔
Teleservice.

v Chapter 9.4 “Teleservice”
18



4 User interface
4.2 Configuration
By using the function File ➔ New (or File ➔ Open) you can create a new
configuration file (setup) or open an already existing one. The working area will
be filled with the corresponding settings. 

Navigation tree A single click with the left mouse button in the navigation tree will position the
entry visibly in the dialog window. 

Clicking on  will reduce the size of the display, one click on  will enlarge
the display again.

A double-click on an entry (e.g. ) will start the change dialog. As
an alternative, a change can be started via the menu bar (Edit ➔  Device data).

Dialog window By double-clicking on an entry in the dialog window, you can initiate the
change dialog. One click on “Arrow to right” ( ) before the entry will list the
current setting in the dialog window, one click on “Arrow down” ( ) will hide
the current setting again.

Current setup If several setup settings are open at the same time, just one simple click on the
name and ...

Navigation tree, for finding 
the settings quickly

Dialog window  
The settings are displayed here.

Current setup
19



4 User interface
... the window becomes an active window.

Functions 
of the right 
mouse button

If you use the right mouse button in the dialog window, different functions will
be available. These functions concern the submenu on which the mouse
pointer was positioned when the right mouse button was pressed.

Example: 
The right mouse button was pressed when it was on the entry “Analog inputs”.

Analog inputs Î Edit

This function starts the change dialog for configuring the analog inputs.
Alternatively, configuring can also be started by a double-click with the left
mouse button.

Analog inputs Î Maximize

This function prompts the display of the current configuration of the analog
inputs. As an alternative, the current configuration can also be displayed by a
click (left mouse button) on “Arrow to right” ( ).

Copy data to clipboard Î Analog inputs

This function copies the current configuration of the analog inputs to the
Windows clipboard. The contents of the clipboard can, for instance, be
imported into an editor or a text processing program.
20



4 User interface
Copy data to clipboard Î All data

This function copies the complete current configuration – not just that for the
analog inputs – to the Windows clipboard. The contents of the clipboard can,
for instance, be imported into an editor or a text processing program.

Print

This function enables the printout of the latest setting. You can select which
parameter groups are printed out, and which are not. Alternatively, the printout
can also be performed via the File menu.
21



4 User interface
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5 File menu
5.1 New
This opens a new setup in the working area. The values will be preloaded with
the factory (default) settings.

After calling up this function, the user must first enter the hardware information
for the instrument. The operation corresponds to the menu function Edit Î
Hardware identifier and is described in Chapter 6.4.

5.2 Open
Opens an existing setup from a file, and present the contents in the working
area.

5.3 Save
Saves the setup that is shown in the working area to a file. It is only necessary
to enter the file name once. If the file is saved again, no query is made about
the file name.

5.4 Save as
Saves the setup that is shown in the working area to a file. Unlike the Save
function, this always asks for a file name. 

5.5 Close
Removes a complete setup from the working area. If changes have not yet
been saved, this can still be done immediately after calling up the Close
function.

5.6 Delete
Deletes a file from a hard disk or another data storage medium.

5.7 Export as RTF text
The current setup can be saved as an RTF file on the PC. 

5.8 Print
After calling up the function, the selection of what is to be printed is made
next. Printing will start when the selection has been concluded. 

A
The deletion of files is irreversible.
23



5 File menu
5.9 Print preview
The printed result is displayed on the screen. You can let several pages be
displayed, and alter the size of the pages on the screen.

5.10 Printer setup
Here you can make alterations to the settings for your printer. When the
program is started, the Windows default printer will always be set as the active
printer.

5.11 Default settings
Here you can make alterations to the default settings for the program. Many
alterations will only take effect after a fresh start of the setup program.

5.12 Exit
This closes the setup program.
24



6 Edit menu
6.1 Undo ...
This undoes the last editing action. In the menu, the item Undo shows which
setting will be undone.

6.2 Restore ...
The Restore function will only be available when the Undo function has been
activated. This function repeats the setting that was previously canceled by
the Undo function.

6.3 Hardware ID ... Web server
Each function has the same effect as a double-click with the left mouse button
on the corresponding function in the dialog window.

The following table provides an overview of the parameters that can be altered
by the user.

H These instructions describe just those parameters that can only be 
configured through the setup program, and not on the instrument.

The description of parameters that can also be configured on the 
instrument can be found in the operating manual B 70.6580.0.
25



6 Edit menu
Parameter Configurable through 
the setup program

Configurable on the
instrument

Hardware ID x -

Country settings x -1

1. On the instrument, you can choose between two operating languages

Device data x x2

2. The general device data can be configured on the instrument, but not the
parameter Setup info (device info).

Screen x x

Analog inputs x x

Binary inputs/outputs x x

Relay x x

External analog inputs x x

External binary inputs x x

Groups x x

Report x x

Limit monitoring x x

Counters/integrators x x

Serial interface x x

Ethernet e-mail parameters x -

Batches/plants x x

Date and time x x

Undocumented 
parameters x x

Customized linearization
x -

Batch texts x -

Math x -

Logic x -

Web server x -

Setup data info x -

x = editable,     - = not editable
26



6 Edit menu
6.4 Hardware ID
This function performs the adaptation of the setup program to the hardware
and extra codes in the instrument. The instrument has three plug-in module
slots, which can have different assignments. The following are available:

- analog input card with 6 analog inputs

- combination i/o card with 3 analog inputs and 
8 binary inputs/outputs

- relay card with 6 relays.

The exact assignment can be determined by comparing the nameplate
(attached to the instrument) and the type designation (see the installation
instructions).

h Choose how the hardware ID is to be determined, and then activate the 
 button.

Hardware ID is 
defined by the user.

Hardware ID is automatically read out 
from a device.

If the hardware ID is read out 
automatically from a device, then 
the present configuration of the 
parameters can also be read out 
as an option.
27



6 Edit menu
User-defined 
settings

With user-defined settings, the user determines the hardware ID.

h Select the slot assignments, and then activate the  button.
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6 Edit menu
h Select the extra codes that have been fitted, and activate the  
button. The interface “RS232” (= RS232 for barcode reader) is provided 
as standard in the paperless recorder, and is thus not an extra (code). 
Please make sure that you select the interface.

“RS232 interface for barcode reader”

Extra code “PROFIBUS-DP interface”

Extra code “Math and logic module”
29



6 Edit menu
h Choose the two languages that are to be sent to the instrument as 
“Language 1” and “Language 2”, and activate the  button.

A setup file can include more than two languages on the PC side, but only two
will be sent to the instrument. These languages must be placed in the first and
second positions in the language list. The choice that is made here can be
revised at a later date.

v Chapter 6.5 “Country settings”

On the instrument, Parameter Î Configuration  Î Device data Î Language
can be used to select the language.

The setting “ ” means that Language 1 and 2
will depend on the installation of the PC program.

Language 1: The language used for installing the PC program. 

Language 2: English (or German if Language 1 is English).

Automatic 
detection

With automatic detection, the hardware read out from a connected device. As
an option, the current settings for the setup configuration can also be read out
( ). 
30



6 Edit menu
6.5 Country settings
After calling up the function, the languages that are available in the setup file
will be shown. If you click on a language with the left mouse button
( ), then its properties will be shown, and they can be moved to a

different position in the list ( ). The first two languages in
the list will be sent to the device (Language 1 and Language 2). 

Language 
editing

All the available languages can be copied and edited. In this way, the user can
also create new languages. 

Sorting and moving languages

Submenu for creating and
altering languages or

device texts
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Characters for the virtual 
device keyboard

H The creating and editing of new and existing languages is 
described in Chapter 11 “Languages”.
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6 Edit menu
6.6 Device data
The device data consist of two sections:

- general device data (also configurable on the instrument) and

- setup info (can only be configured with the setup program).

The setup info can be viewed in the PC evaluation software PCA3000 before
being read in or on opening the data, and can be viewed and expanded in the
menu item EditÎ Supplementary description. 

Enter setup info in other languages
(country settings).

The setup info is entered in the 
window
32



6 Edit menu
6.7 Screen

Start screen The start screen is displayed when the supply voltage is switched on (Power
On). It must have a size of 320 x 240 pixels, with a maximum of 256 colors.

Watermarks 
(curves)

The watermark is shown as a background to the measurement curves when
using curve presentation for the analog inputs. It can have a maximum size of
200 x 100 pixels, with a maximum of 256 colors.

Watermark 
(History)

The watermark is shown as a background to the measurement curves when
using memory presentation for the analog inputs. It can have a maximum size
of 200 x 100 pixels, with a maximum of 256 colors.

If the tick mark ( ) is set, the 
corresponding screen picture 
will be used.

Select screen 

Selecting curve colors

H The color white is used as a transparent color!

H The color white is used as a transparent color!
33



6 Edit menu
6.8 Ethernet e-mail parameters
Five e-mails can be sent to up to three users. The precondition is that the
instrument is connected to a network via the Ethernet interface, and the
Ethernet parameters (Extras Î Ethernet interface) are correctly configured.

Ethernet
e-mail
parameters

v Further information and flow diagrams can be found in the Interface
Description B 70.6580.2.0, Chapter 6.4, and a summary of the error codes
is provided in Chapter 4.9.3.

Max. 3 e-mail addressesMax. 5 e-mails

Binary signal that
activates e-mail dispatch

The mail server is 
configured here. 
Alterations should be 
made by a network 
administrator.
34



6 Edit menu
Mail server

In simple company networks it is often sufficient to specify e-mail transmission
via SMTP (Simple Mail Transfer Protocol):
35



6 Edit menu
6.9 Customized linearization
The customer-specific linearizations (max. 40 interpolation points) make it
possible to connect up sensors that are not defined by the linearizations which
are provided ex-factory.

In the menu Customized linearization you can define the interpolation points
that will be used for setting up the analog channels (Edit Î Analog inputs Î
Linearization Î Customized 1 — 4).

The following procedure has proven to be advantageous for entering a
customer-specific linearization. 

h Select Linearization 1 — 4 (❶).

h Assign a name (❷).

h Choose the type of interpolation (❸).

h Select the sensor type (❸).

h Let the X values be calculated automatically (❺). The values are entered in 
the left-hand column of the interpolation table (❻).

h Enter the Y values in the right-hand column of the interpolation table (❼).

h Use the function (❽) to check the linearization table.

❶

❷

❸

❹

❺

❻ ❼

❽
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6 Edit menu
6.10 Math
The math and logic module is available as an extra (code). It must be ordered
with the instrument, or subsequently enabled through the function Extras ➔
Enable extra codes.

v Chapter 8.2 “Enable extra codes”

The math and logic module are channels that are not available as hardware
but are calculated by the instrument software.

Math channels You can configure the math channels in the “Math” section of the setup
program, or through the menu  Edit ➔  Math. 

In the following example, math channel 3 will be configured:
37



6 Edit menu

 

You must edit the input fields “Variable a”,  “Variable b” or “Timebase” if one 
of the standard functions (difference, ratio, humidity, moving average) has 
been set. If you have set the “Formula” function, then the input field “Formula” 
must be edited. Entry can either be direct or via a dialog ( ).

Example: 
humidity

Function selection

The function is selected here. All other fields can 
subsequently be edited according to the function.

H With humidity measurement, the channel for dry bulb temperature 
has to be specified as variable A, and the channel for the wet bulb 
temperature as variable B.
38



6 Edit menu
Example: 
formula

The formula can be entered directly from the PC keys or by calling up the 
  function.

After calling up the function, the following dialog box will appear:

In the left-hand window you can select the required signal, in the right window
the required operator, and then insert them into the formula by activating the

corresponding button ( ). Instead of using  , you can also
make a selection by a double-click with the left mouse button.  

H For functions ending with ( ), you will have to 
add the closing bracket yourself.

Example: 1)  insert SQRT() --> SQRT(
2)  insert AE1 --> SQRT(AE1
3)  insert ) --> SQRT(AE1)

Click here with the left mouse button to expand or 
reduce the view.
39



6 Edit menu
Operator
overview

Operator
priorities

Operator Explanation Example
+ addition AE1 + AE2
- subtraction AE1 - AE2
* multiplication AE1 * AE2
/ division AE1 / AE2
( opening bracket (
) closing bracket )
SQRT() root SQRT (AE1)
MIN() minimum value 

(of several variables)
MIN (AE1, AE2)

MAX() maximum value 
(of several variables)

MAX (AE1, AE2, AE3)

SIN() sine
(angle of 360° circle)

SIN (AE1)

COS() cosine
(angle of 360° circle)

COS (AE1)

TAN() tangent
(angle of 360° circle)

TAN (AE1)

** x to the power y AE1 ** AE2
EXP() exponential function EXP (AE1)
ABS() absolute value ABS (AE1)
INT() integer portion INT (AE1)
FRC() decimal portion FRC (AE1)
LOG() logarithm LOG (AE1)
LN() natural logarithm LN (AE1)

Priority Math sign / function Comment

high ( ) brackets

SQRT, MIN, MAX, LOG, LN, SIN,
COS, TAN, ABS, EXP, INT, FRC

functions

** exponent (xy)

+, - sign

*, / multiplication, division

low +, - addition, subtraction
40



6 Edit menu
6.11 Logic
The math and logic module is available as an extra (code). It has to be ordered
with the instrument, or subsequently enabled through the function Extras ➔
Enable extra codes.

v Chapter 8.2 “Enable extra codes”

The math / logic module is composed of channels that are not available as
hardware but are calculated by the instrument software.

Logic channels Activate the “Logic” section in the setup program, or use the menu Edit ➔

Logic. 

Editing a logic channels is just the same as entering a formula for a math
channel (Chapter 6.10 “Math”), the difference lies merely in the variables and
operators that are available.

Operator
overview

Operator
priorities

Operator Explanation Example
! NOT ! BE9
& AND BE9 & BE10
| OR BE9 | BE10
^ XOR BE9 ^ BE10
/ rising edge / BE9
\ falling edge \ BE9
( opening bracket (
) closing bracket )

Priority Operator Comment

high ( ) brackets

NOT, ! negation

AND, & AND linkage

XOR, ^ exclusive-OR linkage

low OR, | OR linkage
41



6 Edit menu
6.12 Web server
The integrated web server provides the user with the possibility of checking
the analog and binary inputs to a paperless recorder via the Ethernet as well
as setting the batch data in the instrument.

Depending on the Ethernet configuration (Extras Î Ethernet interface), the
web server for the paperless recorder can be called up from the PC through a
browser (e.g.Internet Explorer) in one of two ways:

- by entering the IP address (e.g.http://10.10.1.179), or

- (for active DNS device names) by entering the 
name (e.g. http://lsntssc).

List of the active web server files.

Read in web server files from data medium.

Export web server files to data medium.

Remove web server files from the setup file.
The data will only be removed when the dialog is

ended by the OK button.

Conversion of variable names to addresses
for web server programming.
42



6 Edit menu
Browser
example

H SVG pictures (SVG = Scalable Vector Graphics) are used within the 
web server. For the correct presentation of SVG, Internet explorer 
requires a plug-in such as the SVG Viewer from Adobe (http://
www.adobe.com/svg). 

H New, specially adapted web server files can be created by the 
manufacturer, if required. Quotation and prices on request.

Navigation area. 
Click with the left mouse button 
to start the page.

Window contents. 
Here you can find the 
latest data
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6 Edit menu
6.13 Setup data info
This function has the same effect as a double-click with the left mouse button
on one of the following functions in the dialog window.

The File info header and File info text can be used for a description of the
setup file. 

This information is stored only within the setup files, and is not transferred to
the instrument.
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7 Data transfer menu
In this chapter, before explaining (from Page 49 on) the function of the data
transfer, it is necessary to provide some general explanation on the topic of
data transfer.

7.1 General
There are two ways of transferring the setup data to or from a recorder:

– transfer via interface, or

– transfer via CompactFlash memory card

7.1.1 Transfer via interface

Data transfer is possible via one of the following interfaces:

Setup via RS232 You will need the interface cable (including adapter) in this case. It is available
as an accessory for the recorder. 

PC Paperless recorder

RS232 (with TTL/RS232 converter) Setup interface

USB (with USB/TTL converter) Setup interface

RS232 RS232

RS485 (plug-in card or converter) RS485

Ethernet Ethernet
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7 Data transfer menu
Setup via USB You will need the interface cable (including adapter) in this case. It is available
as an accessory for the recorder.

RS232 v For the pin assignments, please refer to the Interface Description
 B 70.6580.2.0.

RS485 v For the pin assignments, please refer to the Interface Description
 B 70.6580.2.0.

Ethernet The paperless recorder or a PC can be connected to the network using
normal, commercially available network cables (with RJ45 connector). If the
recorder and a PC are to be connected directly together, please use a
crossover cable.

Starting the 
transfer

Use the toolbar or the Data transfer menu with its functions ““Data transfer to
device”and ““Data transfer from device”” in order to transfer the setup data.

v See Installation Instructions B70.9720.3.

PC

Paperless recorder

H This can be configured either on the recorder or through the setup 
program. If, forexample, the Configuration menu is open on the 
instrument, then the instrument cannot be accessed through the 
setup program.

Chapter 7.5 “Data transfer from device”

Chapter 7.4 “Data transfer to device”
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7 Data transfer menu
7.1.2 Transfer via CompactFlash memory card

Setup
program

Use the toolbar or the Data transfer menu with its functions “Data export to CF
card” and“Data import from CF card” to transfer the setup data.

 

Paperless 
recorder

You can use the paperless recorder to write setup data to the CompactFlash
memory card, or to read from it.

Import/export errors

If an error occurs on the paperless recorder side during transfer from or to a
CF card, it will be indicated in the CompactFlash card menu and will remain
until the error has been eliminated or is overwritten by a fresh error message.

Notes on 
the CF card

In order to be able to read or write to CompactFlash memory cards from a PC,
you will need a card reader/writer.

When you have installed the card reader/writer, and inserted a CompactFlash
memory card, you will automatically have a new drive under Windows. You
can access this new drive just like a normal hard disk, using Windows
Explorer.

H Do not use the menu function “File ➔ Save as ...”

It cannot be used to create a valid CF card for the paperless 
recorder.

Chapter 7.7 “Data import from CF card”

Chapter 7.6 “Data export to CF card”

A
CompactFlash memory cards must only be removed from the card 
reader/writer when the function “Eject removable medium” or 
“Safe removal of hardware” (functions in the PC operating system) 
has been activated first.

H Only one configuration file can be saved to the CF card at any 
time, since there is no file name as a variable. 

Measurement data from several instruments can be on the same 
CF card, since they have unambiguous IDs.
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7 Data transfer menu
Formatting 
a CF card

To format a CF card using the Windows workplace (e. g. Windows XP):

h Make a double-click on the workplace symbol in the “Desktop” area for the 
PC, using the left mouse button.

h Click with the right mouse button on the drive letter for the CF card.

h Select the Format function.

h Select FAT file system.

h Click on the “Start” button.

A
A CompactFlash memory card, (CF card) must be formatted for 
FAT (not FAT32 or NTFS).

If you format a CF card yourself, you must not use fast-formatting 
(quick format). If this is disregarded, a fault free exchange of data 
cannot be ensured.

Select FAT.
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7 Data transfer menu
7.2 Make connection

This function establishes a connection ( ) to a device. A connection to a
device is a precondition for transferring a setup to or from a device via an
interface (serial or Ethernet).

7.2.1 Assistant for device settings

If there has never been any previous communication with an instrument, the
“Assistant for Device Settings” will automatically be started when the first
attempt is made to access the instrument. This helps you to set up a device
list. 

h First select the device version.

h Enter an additional description, if appropriate.

h Set one of the option fields, if appropriate.

h Press the  button.

If the option is active ( ), a check 
is made at the end whether the 
chosen device can be accessed 
via the selected interface.

Here you can choose
whether the device should

be defined as the default
device ( ). The system will

automatically access a
default device, other

devices must be linked
through the device list.
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7 Data transfer menu
Log-in to device

No log-in The default setting of the program is such that the “Master” user is
automatically logged in to a device that is found with the user’s name and
password, and can thus communicate with this device.

Set the option ( ) if you do not want to log in. Please note that it is possible
that some functions will not be operable if you are not logged in. The decisive
factor is the current user list and the access rights that are defined in this list.

Saving ID and 
password

If the “Save ID and password” field is active, the log-in is made to the device
with the data that are stored under the “User ID” and “Device password” that
are entered. The default settings are “Master” for the user ID, and “8200” for
the device password.

If the “Save ID and password” field is inactive, then the log-in is made with the
“User ID” and “Device password” that were used to start the setup program.

h Make your selection, and activate the  button.

Save ID and password

Do not log in.
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7 Data transfer menu
Interface 
selection

h Select the interface which you want to use to access the device.

The next steps depend on the interface or type of connection that has been
selected.

TCP/IP PORT The following parameters must be selected:

Analog modem,  
ISDN

The following parameters must be selected:

IP address /
HOST name

xxx.xxx.xxx.xxx
(Example: 192.168.0.10)

Enter the IP address for your 
instrument. If you enter the 
name, the IP address can be 
determined by clicking on the 
button “Convert HOST name 
to IP address”.

Port number, 
port name

80 The port used for 
communication.

Communications
protocol

HTTP protocol This has a fixed setting, and 
cannot be altered.

Telephone 
number

Enter the telephone number 
for connecting to the required 
device. 

Connect via Select which modem is to be 
used to make the connection. 

Communications
protocol

Modbus protocol This has a fixed setting, and 
cannot be altered.

Device address 1 — 254 Device address for the 
Modbus protocol. 

If modems are applied, they must be preconfigured before they can be used. 
51



7 Data transfer menu
Serial
interface

The following parameters must be selected:

Device list When all settings have been made, the device is entered in the device list.

Connected to COM1, COM2 The PC interface to which the 
paperless recorder is 
connected.

Transmission rate 9600, 19200, 38400 The transmission rate must 
match the one that has been 
set in the device.
9600 must be set if “RS232 
setup interface (TTL)” is 
selected as the control signal.

Control signal RS232 If the RS232 interface on the 
device is used. 

RS232 setup interface
(TTL)

If the setup interface on the 
device is used. 

RS422-RTS If the RS422/485 interface on 
the device is used. RS422-DTR

RS485-RTS

RS485-DTR

Expanded Stop bit and 
parity

The parameters under the 
“Expanded” button must also 
match the corresponding 
device parameters. 

Standard and obligatory 
settings for the control signal 
“RS232 setup interface (TTL)”
are:

Stop bit = 1
Parity = none

Communications
protocol

Modbus protocol This has a fixed setting, and 
cannot be altered.

Device address 1 — 254 Device address for the 
Modbus protocol. If the 
“RS232setup interface” is 
used as the control signal, 
then the device address will 
be ignored – it does not have 
to match the address in the 
device.
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7 Data transfer menu
7.2.2 Device list

All devices that have been defined are shown in a device list. The interface
parameters are also administered here, and new, additional devices can also
be defined in the device list.

Use the  button to make a connection to a device. 

When deleting entries, you can use the Ctrl key on the PC keyboard and the
left mouse button to select several devices at the same time and delete them.

A successful connection produces a change in the toolbar.

Make a connection
with the selected device.

Remove device(s) from the list.

Alter properties
Add a new device

Automatically search the
interfaces for devices.

Use the assistant if the 
function  
“Add new device” or 
“Change properties” 
is executed.

Alter properties

Update presentation of
the device list.

Change device identifier
„online“ in the device.

Import a device list from a file
(e.g. from another PC).
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7 Data transfer menu
Not connected

Connected

7.3 Disconnect
This breaks an existing connection between the PC and a device.

7.4 Data transfer to device
Transmits a setup to a device.

7.5 Data transfer from device
Read in a setup from a device. If there is no connection, the program will
automatically attempt to access the default device.

7.6 Data export to CF card
The setup will be saved on a CompactFlash card. The CompactFlash card can
be read in to the instrument, using the Memory manager menu.

7.7 Data import from CF card
This reads a setup from a CompactFlash card, and displays it in the working
area.
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8 Extras menu
8.1 Enable program options
If no valid serial number was entered during the installation of a program, then
it will only run in demo mode. You can use this function to register a program
at a later date and to convert it into a 30-day test or full version.

8.2 Enable extra codes
This function is intended for later extensions within the paperless recorder
(e. g. enabling the extra code for “Math and logic module”).
After starting up the function, the function must be used
to read out a code number from the instrument, which is then passed on to the
manufacturer. The manufacturer will then generate a “release number”. The

 function is used to transmit this release number to the
instrument, which will then enable the new device functions.

8.3 Date and time
This function is used to match the date and time for an instrument to the PC
time.

The  and  buttons are used to make a new
setting of date and time for a device. Both functions use the details in the
“New setting” selection as the basis for adjustment.

The  button is used to make date and time settings for a device.
The “Set” function generates a new configuration in the instrument.

H In order to use a function in the Extras menu, there must be an 
existing connection to an instrument.
If there is no connection, the setup program will try to access the 
default device from the device list. If no default device has been 
defined, then the device list will appear on the screen and the user 
must set up a connection by hand. 

Send the date and time to a device.

Terminates the function.

Synchronize a device 
with the PC time. 
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8 Extras menu
The  function only sets the time. If there is a discrepancy
of more than 30 seconds, then the function will not be carried out. The
“Synchronize” function does not generate a new configuration.

 ensures that the device clock is read out continually

(cyclically). The continual read-out can be ended by activating . The
clock cannot be adjusted while it is is being continually read out.

8.4 Create screenshot
This function provides you with another option for documenting settings or
events.
Start the function and operate the “Create” button. A screen printout
(screenshot) will be created for the device that is connected. You can save the
screenshot as a bitmap, or print it out directly.

8.5 Ethernet interface
It is possible to look at and alter the active settings for an instrument if it is
connected to the PC via an Ethernet interface.

8.6 Write interface texts
With this function you can: 

- read and write batch texts for the current batch,

- read and write an additional batch text (e.g. a recipe),

- write event texts.

The function is independent of the present setting in the dialog window (setup
file). The data can be transmitted to a device, without causing a new
configuration.

H If the dialog is terminated by pressing the OK button, then the 
attached device will carry out a restart (reset). If you just want to 
look at the settings, then leave the dialog by pressing the cancel 
button.
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8 Extras menu
Batch data All the editable fields can be altered and sent to the attached device. If a batch
report is terminated at the instrument, then the instrument (= device) will
continue to use the configuration data. 

Comment A text (e.g. a recipe) up to 400 characters long can be sent to the attached
device and so saved in the course of a batch report. The text can be called up
on the instrument in the visualization of a finished batch report.

If a batch report is terminated at the instrument, then the comment will be
deleted from the instrument. Since the data are retained in the dialog window
of the setup program until new data are received, it is possible for edited data
to be sent to an instrument more than once. 

Batch data for each plant

Comment for each plant

Event text for each plant and 
the associated group

Editable field

Read data from device

Send data to device
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8 Extras menu
External
event text

This function can be used to write a group-specific event text in the event list
of the recorder. It must be taken into account that the groups are, in their turn,
assigned to the plants.

8.7 Password management
The password management function can be used to alter the passwords for
the users and their rights, as well as the standard rights (applied when no user
is logged in to the device).

All the characters that are listed can be used for allocating passwords. 

Plant number Group Plant (batch)

1 1 — 9 1

2 1 — 3
4 — 6
7 — 9

1
2
not assigned

3 1 — 3
4 — 6
7 — 9

1
2
3

Tables 1 — 16
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8 Extras menu
h Scroll through the individual tables and check whether the character 
selection is adequate for your requirements.

h If not, look for the first available table, and then define additional 
characters.

h When you have finished defining the characters, activate the  
button.

In the following dialog, the passwords can be allocated for the users, and the
user rights and standard rights can be viewed and altered by using the

 button.

8.8 Reset user list
This function resets the device user list to the standard settings (user:
“Master”, password: “9200” and user: “User”, password: “0”). This function
will only be available if the user who is logged in to the setup program has the
corresponding access rights (e.g. logged in as Specialist).

v Chapter 3 “Log-in and rights”

8.9 Delete internal memory
This function deletes the device-internal memory. The function will only be
available if the user who is logged in to the setup program has the
corresponding access rights.

v Chapter 3 “Log-in and rights”

You should only use this function after the installation of the instrument, or
after setting up a new plant. 

Enter the characters here
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8 Extras menu
When this function has been performed, the attached device will carry out a
restart (reset).

8.10 Renew log-in / alter password
The function Renew log-in / Alter password is used to

- activate the user and password query at the program start, and

- alter the current password.

This function only has an effect on the operation of the setup program, not the
recorder.

Activation of the user and password query at the program start

When the setup program is installed for the first time, there will not yet be a
query of the user name and password when the program starts. You will
automatically be logged in as “Specialist”, with a blank password.

Proceed as follows:

h Start the function “Renew log-in / Alter password”.

h Show the options.

h Activate the option “After log-in – alter password” and click on the 
 button.

H The deletion of the memory contents is irreversible. All the data 
that were recorded up to this moment will be deleted, and only the 
active configuration will be retained.

Show the options.
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8 Extras menu
h Enter the password – the “Old password” field remains empty.

When the entry has been concluded, the new password is activated by

clicking . From now on, the user name and the password will be

requested at the program start.

Password alteration

Altering a password is very similar to activating the password query. The only
difference is that, in this case, the “Old password” field must not remain
empty.

H Initially, no start password is assigned to the “Maintenance” user 
either. At program start, log in with the “Maintenance” user name 
and enter a password as described above.
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8 Extras menu
8.11 Text library
The text library contains the various operator languages. When a new setup
file is created, the languages will be copied to the setup file, if requested. The
first two languages (Language 1 and Language 2) are transferred to the
instrument, and can be selected there. 

The operation of the text library is identical to the menu item Edit  Î Country
setting.

v Chapter 6.5 “Country settings”

v Chapter 11 “Languages”
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9 Window menu
9.1 Cascade
If several dialog windows are open at the same time, this function has the
effect that all windows are shown with a small offset to one another. A double-
click with the left mouse button brings a window into the foreground.

9.2 Tile horizontally
If several dialog windows are open at the same time, this function has the
effect that the various windows are shown one above another. A double-click
with the left mouse button in a window makes that window active.

9.3 Arrange symbols
All the open windows are minimized – they disappear from the screen, but are
not closed. 

H The usual Windows options are available for the positioning of
the dialog windows.

Enlarging and minimizing

Reducing and maximizing

Close

A double-click with the left mouse button 
produces maximum enlargement.
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9 Window menu
9.4 Teleservice
You can use this function to switch the Teleservice window in or out of
display. The position  is independent of the position of the dialog window.

You can use Teleservice to request the latest data from a paperless recorder. 

In order to use Teleservice, there must be an existing connection to an
instrument.

v Chapter 7.2 “Make connection”

You can switch Teleservice into or out of display via the Window menu.

Shifting the 
Teleservice
window

The Teleservice window, too, can be shifted. The same possibilities apply as
for shifting the toolbar.

v “Shifting the  toolbar” on page 18

Close Teleservice window

Click here to switch further registers 
into the display (if available)

Active register

Click here to select the register as 
the active register

Shift the Teleservice window
v “Shifting the  toolbar” on page 18
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9 Window menu
9.5 Connection status
You can use this function to switch the connection status window in or out of
display. The position  is independent of the position of the dialog window.

v See “Connection status” on page 18.

Position the mouse pointer here, and,
holding the left mouse button down, shift the
Teleservice window to a different position.
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10 Info menu
10.1 Info on setup
Here you can find out the version number of the setup program. Please have
the version number available if you contact the service hotline.

10.2 Software documentation
This function calls up the available instrument and software documentation in
PDF format.

10.3 Registered license numbers
Here you can find out the license number of the setup program. Please have
the license number available if you contact the service hotline.

10.4 Program folder
Here you can obtain information as to which folders (directories) on the hard

disk or in the network are used by the setup program. If you operate the 
button, the contents of the folder will be displayed.
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11 Languages
For the languages, a distinction is made between:

- the languages for a setup file 
(Edit Î Country settings) and

- the languages in the text library of the setup program
(Extras Î Text library). 

It does not matter where a language is added or changed, it can be copied
between these sections in both directions.

It is not possible to edit a standard language. A standard language can be
recognized by the fact that there are no editable fields in the dialog window. If
a standard language has to be altered, then it will have to be recreated.

11.1 Adding a language
h Choose the language that is to be used as a basis in the dialog window, by 

clicking on it with the left mouse button.
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11 Languages
h Select the function Language Î New language Î Create.

A copy of the language will be created, and the corresponding summary data
will be displayed. The presence of white fields instantly shows you that this
language can be edited.

h First of all, give the new language a new name, so that it can be identified 
later.

h The function Language Î Edit can now be used to make alterations to the 
new language.
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11 Languages
11.2 Language editing

When a new language has been created, the texts are shown as red text on a
white background. This indicates that these texts have not yet been edited (or
translated). 

Use the left mouse button to click in a text field, and then it can be edited. If
you leave the field, the entry for this field is finished. It will be shown as black
text on a white background. This indicates that the text has been edited (or
translated).

Select the language in the left-hand column. 
The language cannot be edited here.

Select the language in the 
right-hand column. Editing 
is only possible in this 
column.

Selection of the 
text category.

Edited text

Unedited text

Active field
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11 Languages
Toolbar The toolbar can be used to alter the status of a text and activate a filter. 

Errors The following errors may occur during text entry, and are indicated by a
colored background: 

Mark the text with a 
bookmark.

Mark the text as edited 
(translated).

Mark the text as  
to be checked

Mark the text as unedited.

Filter

The filter is used to
reduce the number of

texts shown in the list.

Background Explanation

blue Not enough memory available. The total number of texts 
is too high, and will have to be reduced.

yellow The text that was entered is too long – it does not fit into 
the intended window.

mauve The text that was entered contains characters that the 
instrument cannot display.

brown Error when editing a wildcard (#). The # symbol is used 
as a wildcard. The instrument software automatically 
generates text to take the place of the wildcard. 
Example: “Device ID #1,100”. 
“Device ID” can be changed, but not “#1,100”.

H If errors occur, they must be removed. 
A setup file that contains errors must not be transferred to an 
instrument.
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11 Languages
11.3 Device character set
For new languages, you can define the characters that may be used in
entering text for the paperless recorder.

v Chapter 11.1 “Adding a language” 

h Left-click on a group.

h Then edit the characters that are available in the group.

The characters that are defined here will be visible for text entry to the
paperless recorder. 

Group of characters

Characters in the group
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12 PCA3000 and PCC
12.1 PC Evaluation Software PCA3000

PCA3000 is the professional evaluation software for data analysis of the archived
instrument process data.

PCA3000 is the ideal software for the best-quality graphic and alphanumeric
display of electronically stored measurement data. The software supports
multi-user functionality, so that different users can access the same data.
PCA3000 runs under Windows NT, Windows 2000 and Windows XP.

Data storage The life-cycle  archive  data  structure  enables  on-demand  saving  and
archiving  of  all  process  data,  clearly  and  simply,  in  a  single  file.

Data archive Archive data can be read out and visualized directly from a CD-ROM or DVD (a
transfer to the hard disk is not necessary).

Data export Data export at the HTML level, or as an ASCII text file (for evaluation in Excel).

Communication The data transfer program PCC (Communication Server software) is perfectly
matched to PCA3000, and enables the comfortable read-out of data through
the interface, using RS232/ RS422, Ethernet, a modem, or through the setup
interface.

H PCA3000 is described in the Operating Instructions 
B 70.9701.0 in detail.
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12 PCA3000 and PCC
12.2 PCA Communications Software (PCC)

PCC is the professional archive software: it transfers the data (setup, serial or
Ethernet) from the recorder (or several recorders and controllers) via an
interface, and deposits them on a PC or a network.

H PCC is described in detail in the Operating Instructions 
B 70.9702.0.
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13 Character set
Entering
special 
characters

Any (special) characters in the setup program that cannot be input directly
from the keyboard of the PC can be entered with the help of the A key and a
corresponding numerical combination.

Example The special character © has to be entered:

h Position the cursor with the mouse, or by using the cursor keys, on the 
point where the character is to be inserted.

h Press the A key and hold it down

h Enter the number combination 0169 in the number block (on the right-hand 
side of the keypad) – the leading zero must be entered as well.

h Release the A key.

The character © is inserted at the cursor position.

Cyrillic 
characters

If “Russian” has been selected as the language for the instrument, then the
characters 0192 … 0255 will be replaced by Cyrillic letters in the instrument.

Example of a 
character code

H The character set depends on the language of the operating 
system that is used, and may be different from the example. 

Number Char. Number Char. Number Char. Number Char.
032  080 P 0161 ¡ 0209 Ñ
033 ! 081 Q 0162 ¢ 0210 Ò
034 " 082 R 0163 £ 0211 Ó
035 # 083 S 0164 ¤ 0212 Ô
036 $ 084 T 0165 ¥ 0213 Õ
037 % 085 U 0166 ¦ 0214 Ö
038 & 086 V 0167 § 0215 ×
039 ’ 087 W 0168 ¨ 0216 Ø
040 ( 088 X 0169 © 0217 Ù
041 ) 089 Y 0170 ª 0218 Ú
042 * 090 Z 0171 « 0219 Û
043 + 091 [ 0172 ¬ 0220 Ü
044 , 092 \ 0173 - 0221 Ý
045 - 093 ] 0174 ® 0222 Þ
046 . 094 ^ 0175 ¯ 0223 ß
047 / 095 _ 0176 ° 0224 à
048 0 096 ‘ 0177 ± 0225 á
049 1 097 a 0178 ² 0226 â
050 2 098 b 0179 ³ 0227 ã
051 3 099 c 0180 ´ 0228 ä
052 4 0100 d 0181 µ 0229 å
053 5 0101 e 0182 ¶ 0230 æ
054 6 0102 f 0183 · 0231 ç
055 7 0103 g 0184 ¸ 0232 è
77



13 Character set
056 8 0104 h 0185 ¹ 0233 é
057 9 0105 i 0186 º 0234 ê
058 : 0106 j 0187 » 0235 ë
059 ; 0107 k 0188 ¼ 0236 ì
060 < 0108 l 0189 ½ 0237 í
061 = 0109 m 0190 ¾ 0238 î
062 > 0110 n 0191 ¿ 0239 ï
063 ? 0111 o 0192 À 0240 ð
064 @ 0112 p 0193 Á 0241 ñ
065 A 0113 q 0194 Â 0242 ò
066 B 0114 r 0195 Ã 0243 ó
067 C 0115 s 0196 Ä 0244 ô
068 D 0116 t 0197 Å 0245 õ
069 E 0117 u 0198 Æ 0246 ö
070 F 0118 v 0199 Ç 0247 ÷
071 G 0119 w 0200 È 0248 ø
072 H 0120 x 0201 É 0249 ù
073 I 0121 y 0202 Ê 0250 ú
074 J 0122 z 0203 Ë 0251 û
075 K 0123 { 0204 Ì 0252 ü
076 L 0124 | 0205 Í 0253 ý
077 M 0125 } 0206 Î 0254 þ
078 N 0126 ~ 0207 Ï 0255 ÿ
079 O 0128 € 0208 Ð

Number Char. Number Char. Number Char. Number Char.
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14 Index
A
Alter password 60
Arrange symbols 63
Assistant for device settings 49
Automatic detection 30

B
Batch data 57
Batch texts 56

C
Cascade 63
Clipboard 21
Close 23
Color settings 33
Comment 57
Commissioning 7
CompactFlash 45, 47
Configuration 19
Connection 49
Connection status 18, 65
Country settings 31, 69
Create screenshot 56
Current setup 19
Curve colors 33
Customized linearization 36

D
Data export to CF card 54
Data import from CF card 54
Data transfer 45
Data transfer from device 54
Data transfer to device 54
Date 55
Date and time 55
Default settings 24
Delete 23
Demo version 12
Device info 26, 32
Device list 53
Dialog window 19, 63
Directory 67
Disconnect 54
Display printout 56
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14 Index
E
E-mail 34
Enable extra codes 55
Enable program options 55
Errors 72
Ethernet 45, 56
Event text 56, 58
Exit 24
Extra code 27, 29, 55

F
FAT 48
Folder 67
Formatting 48
Formula 38
Formula editor 38–39

H
Hardware 27, 30
Hardware and software requirements 9
Hardware ID 27
Humidity measurement 38

I
Import/export errors 47
Info on setup 67
Installation 11, 13
Interface 45, 51
Interface texts 56

K
Keys 9

L
Languages 26, 30–31, 62, 69
License agreement 11
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